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Overview 

AGSYS is the post-processing software package for the Microg 
LaCoste's Turnkey Airborne Gravity Systems 6 / 7 (TAGS6 / 7). 
AGSYS takes raw field data from the survey aircraft and a 
ground GPS base station and processes it to produce free air 
and Bouguer gravity anomalies along survey lines. The 
processed data can be exported to mapping packages such as 
Geosoft Oasis Montaj or the Generic Mapping Tools (GMT) for 
such tasks as survey line leveling, gridding, and mapping. 
AGSYS is designed to be used in the field to immediately 
process data after each survey flight. Processing of a survey 
flight normally takes one to two hours. With this rapid data 
turnaround, data quality issues and possible system problems 
can be identified and operations issues (such as reflights, 
hardware diagnostic checks, etc.) can be dealt with in a timely 
fashion.   

NOTE  AGSYS and the TAGS-6 / 7 hardware have been under joint 
development since 2004, and are designed to work as a unit. 

  AGSYS is not designed to process any other type of data from 
any other instrument system. Use of any processing software 
other than AGSYS with TAGS-6 / 7 data cannot be expected to 

work or produce good results. 

In general, the processing workflow in AGSYS proceeds from left 
to right along the main menu, and from top to bottom in the 
drop-down menus under each main menu. After the initial setup 
of the global survey parameters, the gravity baseties used in 
the survey, and the TAGS-6 / 7 gravimeter parameters, the 
daily processing time is spent in the Flights and Lines menus. 

Documentation 

Reference the following manuals for use with the TAGS-6 / 7 
Turnkey Airborne Gravity System.  

• TAGS-6 / 7 Turnkey Airborne Gravity System 6 / 7 User’s 

Manual 

• TAGS-6 / 7 PiperPro Processing Software Manual 
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Conventions 

Instructions assume familiarity with common Windows® 
navigation, tools and operations.  

Dialog menus, commands, dialog titles, labels and options are 
bolded text in the user instructions. WARNING and IMPORTANT 
notes are highlighted in red. 
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Installation Summary 

AGSYS Data Processing Software 

AGSYS version 1.1.29 11 Nov 2023 

 

Operating Systems 

Microsoft® Windows 10 

Microsoft® Windows 11 

 

Required Applications  

● Waypoint GrafNav/GrafNet™ installed size: 75 MB 

− Version 8.40.1214 or greater 

− Typical installation location for Waypoint GrafNav/GrafNet™ 

C:\NovAtel\WayptGPS840  

● MATLAB® Compiler Runtime size: 382MB 

− Installed as part of AGSYS installation 

− Version R2013b v82 or greater 

− Typical installation location for MATLAB® runtime libraries 

C:\Program Files\MATLAB\MATLAB Compiler Runtime 

 

Recommended Software 

Ghostscript is the recommended application for a postscript and 

PDF interpreter/renderer of the data plots from AGSYS.  

Download from: 

https://ghostscript.com/releases/gsdnld.html 

https://ghostscript.com/releases/gsdnld.html
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Waypoint GrafNav/GrafNet™ Installation Notes 

The Waypoint GrafNav/GrafNet™ software must be installed prior to 

installing AGSYS. It is strongly recommended that the Waypoint 

GrafNav/GrafNet™ software be installed in the default location. It may fail 

to install if installed in the Program File directory.  

The Waypoint installer does not install geoid files, they must be 

hand copied from the Waypoint CD or downloaded from the 

NovAtel website: https://novatel.com/support/waypoint-

support/waypoint-geoids to the hard disk. The recommended 

procedure is to copy the entire “Geoid” folder to the Waypoint 

installation directory.  

NOTE  Some commonly used geoids such as EGM96, EGM2008 are 
ready to use, others may be in .zip files which will need to be 

expanded before use. 

AGSYS Installation 

The following software packages are included with this 

installation: 

The AGSYS software version 1.29 or updated version in the 

future  

MATLAB® Compiler Runtime (MCR) R2021b v82 382 MB 

AGSYS Installer Files  

● AGSYS_Installer_mcr.exe 989.348 MB 

● AGSYS_Installer_web.exe 14.180 MB 

Installation Steps 

1. Copy the appropriate installer file to your site installation 

folder.  

2. The installers also install the MATLAB Component Runtime 

(MCR) library if needed.  

− The _web installers use the internet to install the MCR from 

the MathWorks website.  

− The _mcr installers package the MCR installation, so they do 

not require internet access. 

https://novatel.com/support/waypoint-support/waypoint-geoids
https://novatel.com/support/waypoint-support/waypoint-geoids
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− If a compatible version of the MATLAB MCR is already 

installed, that part of the installation is skipped. 

3. Double click on the appropriate installer for your site. Have 

patience as it may take a while before the installation dialog 

appears on your screen. 

4. When the AGSYS Installer dialog (Figure 2-1) appears: 

− If your site internet uses a proxy server, click the 

Connection Settings button and insert Server, Port and 

User name and Password. Then click OK. Figure 2-2 shows 

an example Connection Settings dialog.  

− If your site does not use a proxy server, then click Next to 

start the installation process.  

 

Figure 2-1 AGSYS Installer Dialog 
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Figure 2-2 Connection Settings Dialog 

 

5. The Contacting MathWorks dialog (Figure 2-3) appears 

and checks the system for a MATLAB installation: 

− If MATLAB is not installed on your system, proceed to the 

MATLAB Compiler Runtime (MCR) Installation section.  

− If MATLAB is installed on your system go to the MATLAB 

Compiler Runtime Already Installed section. 

 

 

 

 

 

Figure 2-3 Contacting MathWorks Dialog 
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6. In the Installation Options dialog (Figure 2-4), enter the 

full installation path for your site AGSYS installation location.  

− It is highly recommended to accept the default location.  

− Check the “Add a shortcut to the desktop” to create a 

shortcut icon on the desktop. Highly recommended. 

Then click Next. 

The Folder Selection dialog appears confirming the 

destination folder. Click Yes to create it. 

 

Figure 2-4 Installation Options Dialog 



 
 

 
 

2-6  Software Installation 

 Release 115-780-007B, Release Date 15 Oct 2024 

Runtime (MCR) Installation  

AGSYS requires the MCR to run. If the MCR is not installed, the 

required MATLAB MCR will be installed. 

NOTE  Some AGSYS installation bugs have been noted. Please review 
the MATLAB Installation Bugs section below, describing known 

issues. 

1. The Required Software dialog (Figure 2-5) starts the 

MATLAB MCR installation if the MCR is not found on your 

system.  

− It is recommended to accept the default installation location. 

Click Next. 

− Click Yes in the Folder Selection dialog to create the 

MATLAB destination folder.  

− Read and Accept the MathWorks MCR License Agreement 

pop-up by clicking Yes. Then click Next. 

Figure 2-5 Required Software Dialog: Default MCR Location . 
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2. The Confirmation dialog (Figure 2-6) displays the AGSYS 

and MCR installation location. If correct, click Install to 

begin the installation process.  

Figure 2-6 Confirmation Dialog 

3. The installation process may take fifteen or more minutes. A 

% Complete dialog (Figure 2-7) displays the progress of the 

installation.  

4. An Installation Complete dialog (Figure 2-8) displays when 

the required software was successfully installed.  

5. Proceed to the License section below.  

 

 

 

 

 

 

Figure 2-7 % Complete Dialog 
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Figure 2-8 Installation Complete Dialog 

Complier Runtime Already Installed 

If MCR is already installed on your system, the Required 

Software dialog (Figure 2-9) displays the current installed 

location on your system. Click Next. 

Figure 2-9 Required Software Dialog: MATLAB Already Installed 
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1. A Confirmation dialog (Figure 2-10) displays the packages 

to be installed.  

 

Figure 2-10 Confirmation Dialog 

 

2. If correct, click Install. 

− Installation process takes several minutes to complete. 

 

3. An Installation Complete dialog (Figure 2-11) displays 

when the installation has completed successfully. Click 

Finish and proceed to the License section.  
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Figure 2-11 Installation Complete Dialog 

 

License 

After installation, a license key for each computer is needed to 

run the AGSYS software. The license key is tied to a specific 

computer and is reusable for future updates on that computer. 

Be sure to save the license file in a safe, easily remembered 

location. 

1. Double Click on the AGSYS shortcut icon.  

− Be patient as it may take a few minutes for the LicManage 

dialog to appear.  

− A known AGSYS bug causes the appearance and function of 

the shortcut to be incorrect until the shortcut properties file 

has been edited. Refer to MATLAB installation Bugs section 

below for instructions. 

2. An Error Dialog appears first with the message: “ERROR--- 

MGL license file for wrong computer!!!” 

− Click OK to acknowledge.  

 

about:blank
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3. When the LicManage dialog displays. 

− Click Request license file.  

− In the Request pop-up enter your company name. 

−  In the Output MGL License request file dialog, save the 

AGSYSMGLLicReq.dat file in an easily remembered location 

on your computer.  

− The AGSYSMMGLLicReq.dat file is unique for each computer. 

4. Write down the email address displayed in the Send lic 

dialog.  

− Click OK to dismiss the dialog. (It does not automatically 

send the file.) 

− Email the AGSYSMGLLicReq.dat file to the email address 

that was listed (tianyou.chen@microglacoste.com) and wait 

to receive your site license file (AGSYSMGLLicense.dat). This 

usually takes less than 24 - 48 hours during a normal 

business week.  

5. Upon receipt of the AGSysMGLLicense.dat file, manually 

copy this file to an easily remembered location on your hard 

drive. 

− Double click on the AGSYS icon. In the LicManage dialog 

click Install license file.  

6. In the MGL License file browser, browse to the location of 

your license file and click Open.  

− It copies the license file to the appropriate location. 

7. The Please select Waypoint installation folder browser 

(Figure 2-12) appears.  

− If the Waypoint software has been installed in the default 

location, do not select (highlight) any folder: just click 

Select Folder. This selects the WayptGP890 folder. 

−  If Waypoint was installed in a non-default location, please 

navigate to the installation folder (it will contain a file named 

“wGrafNet.exe”, among many others) and select that folder. 

− Enter the Waypoint version on your system. Must be 8.40 or 

greater. Click OK. 

− When the initial AGSYS window appears (Figure 2-13), click 

Continue to begin TAGS-6 / 7 data processing 
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Figure 2-12 Waypoint Folder Selection Dialog 

Figure 2-13 Main Start-up Window For AGSYS 
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Software Uninstall 

The AGSYS software can be uninstalled from the Windows® 

Control Panel, Uninstall program. There may be AGSYS and 

MATLAB files that need to be manually removed.  

MATLAB Installation Bugs 

Start Bugs 

You may need to edit the target filename in both the Windows 

Start menu and AGSYS desktop icon. The installation may have 

appended an extra .exe extension to the filename.  

Fix 

Right click on the desktop icon or the Windows Start menu 

entry and select Properties and delete the extra .exe extension 

from the Target location. 

File Permissions 

It is highly recommended to use the default installation 

locations. Some file permissions issues have been noted when 

located elsewhere.  

Error Log File  

The error log is always created even if there are no errors to log 

(in that case, the file is empty). The error log file location is 

dependent upon where the AGSYS was launched. For example: 

if run from the Desktop icon, the error log file is also located on 

the desktop. 

To determine the location of the error log file: 

● Launch AGSYS. 

● From the AGSYS File menu, select Set working directory. 

The location that the Select Directory to Open browser 

windows opens is the location of the error log file. 
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Verify TAGS Positions.prf File 

Verify the TAGS positions.prf file is in the Waypoint 

Grafnav/Grafnet installation folder (Figure 2-14). The first time 

AGSYS is run, the Waypoint directory is automatically checked. 

The TAGS positions.prf file is automatically created if missing.  

The typical standard location is C:\NovAtel\WayptGPS90\. The 

folder should also contain many other .prf files.  

 

Figure 2-14 WayptGPS890 Folder 
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Waypoint GrafNav/GravNet™ License Key 

For versions < 8.70, the Waypoint GrafNav/GravNet™ license key is 

shipped on a USB stick with the TAGS-6 / 7 hardware system. This 

license key is required to generate the flight and line data. While the 

survey, baseline and meter function are available without using the 

license key, it is highly recommended to always use the license key when 

starting the AGSYS software. The GrafNav error message (Figure 

2-15) displays if the license key is missing.  

For newer versions (>8.70) there is no hard license key – a license file is 

generated for the specific PC the Waypoint GravNav/GravNet™. Details 

of how to manage the license are detailed in the user manual.  

 

 

 

 

 

 

Figure 2-15 Missing Waypoint Hardware License Key 
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AGSYS File Structure 

The typical installation location for the AGSYS application is user 
specified. An example installation below shows the list of files 
that are typically found in the main installation folder (Figure 3-
1) and the application folder (Figure 3-2). 

Installation Folder 

 

 

 

 

 

Figure 3-1 Sample Installation Folder 

 

Figure 3-2 Example AGSYS Application Folder 

 

Survey Folder 

The survey folder location is user specified. The following 
example shows the main survey folder (Figure 3-3). The 

AGSYS_Projects\MGL Survey\2 folder is the user specified 
flight number and contains the process data folders for both the 

GPS and Gravity. Figure 3-4 shows an example GPS processed 
data folder.  
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The raw folder contains the corresponding raw aircraft (Remote) 
and base station (Master) data. The operator must be diligent in 

renaming the raw GPS data files using aircraft and base in the 
filename to distinguish the base station (Master) .pdc file from 

the aircraft (Remote) .pdc file.  

 

 

 

 

 

Figure 3-3 Example Main Survey Folder 

 

Figure 3-4 Example GPS Folder 
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MATLAB File Structure 

The typical installation location for MATLAB® is C:\Program Files\MATLAB\MATLAB 
Runtime. Refer to Figure 3-5. 

 

Figure 3-5 Example MATLAB Folder 

GrafNav/GrafNet File Structure 

The typical installation location for GrafNav/GrafNet is C:\NovAtel\WayptGPS890. 
Refer to Figure 3-6. 

 

Figure 3-6 Example GrafNav/GrafNet Folder 
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Starting AGSYS 

Double click on the AGSYS icon to launch the AGSYS software 
splash screen (Figure 4-1). The only active menus at startup are 

Survey and Help. 

 

Figure 4-1 AGSYS Splash Screen 

 

 The Help menu, Manual option opens a pdf version of this 
manual and the About option shows the AGSYS software 

version.  

Under the Survey menu, Exit is the only active option on the 
Splash Screen. 
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Click Continue to launch the main AGSYS data processing 

dialog (Figure 4-2). 

 

Figure 4-2 AGSYS Main Processing Dialog: Survey Menu 

 

All the options (except View/Edit survey) under the Survey 
menu are now active. The other menu options become active in 

sequence as required structures are created.  
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Survey Menu 

Use the Survey menu (Figure 4-2) to create a new survey or to 
access an existing survey.  

• Once you have opened an existing survey the View/Edit 

survey command becomes available. 

• A survey must be created before calculating the terrain 

corrections and creating baseties, meters or flights. 

• Baseties and meters must be created before flights can be 

created.  

• Once a survey has been opened you must exit and restart 

AGSYS to open a different survey. 

New Survey 

The New Survey option launches the Specify survey 

directory browser (Figure 4-3).  

 

Figure 4-3 Specify Survey Directory Browser Dialog 
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• Move to the survey location for your site and either create a 

new folder or select an existing folder that does not yet 

contain a survey file.  

• Clicking Select Folder launches the EditSurvey dialog (Figure 

4-4). 

 

Figure 4-4 Edit Survey Dialog 

 

View /Edit Survey  

Use the View/Edit option to configure the Survey parameters. 
This dialog is launched automatically when creating a new 
survey and can be used to modify an existing survey.  

View/Edit Survey Parameters 

Survey ID: A free-format string used to describe the survey. 
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Survey IGF: Select the International Gravity Formula (IGF) to 
be used for the survey. Typically set to GRS80. 

NOTE The IGF30 is a very old formula, which should only be used 

together with the Old Potsdam datum in the Baseties dialog. 

Survey Working Projection: The Universal Transverse 
Mercator (UTM) coordinate system is used for internal 

calculations. 

• Enter the UTM Zone Number (dependent upon the survey 

longitude). 

• Select N or S UTM hemisphere. 

• Or enter an approximate central meridian for the survey in 

the UTM Zone Number text box. The correct UTM zone value 

is automatically calculated from the survey central meridian. 

o The value must be entered using 'e' or 'E' for East 

Longitude or 'w' or 'W' for West Longitude. 

o For example, Longitude 107 W could be entered in any of 

the following acceptable formats:  

107w or 107W 

107 w or 107 W 

 

• Click Accept  

o Creates the survey.mat file in the survey folder. 

o If you have Microsoft Access installed the .mat file 
may appear as a Microsoft Access table file. This does 

not affect AGSYS 

• Click Close to exit without creating the survey.mat file. 

o An Unsaved data confirmation dialog requests 

confirmation to close without saving data. 

o Click Yes to close without saving the data. Click No to 

return to the EditSurvey dialog.  
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Open Survey 

• Select an existing survey from the list displayed in the 
Survey menu (Figure 4-5). The Survey menu lists the last 

five surveys accessed.  

•  Or Click Open Survey to launch the Specify survey directory 

browser. 

o Navigate to the survey folder 

o Select the folder and then click Select Folder  

o The main AGSYS dialog displays the path to the 

selected folder in the Survey name field. 

 

Figure 4-5 AGSYS Dialog Example Survey Menu Options 
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If the selected survey has existing baseties, meters and flights 
then their corresponding menus are active. If the survey is 

missing any required configurations, then the Flights menu is 
not accessible. 

To make any changes to the survey, baseties or meters, select 

View/Edit option under the appropriate menu. The appropriate 
edit window opens allowing users to make changes.  

IMPORTANT  AGSYS does not recognize when survey, basetie or meter 
information has changed and the line data is not recomputed. If 
changes are made to the survey, basetie or meter information, 

line data must be calculated manually.  See Appendix D 

Software Troubleshooting for more information.  

Preferences 

To select the Waypoint installation folder, select the 

Preferences option under the Survey menu. 

Exit 

Selecting Exit under the Survey menu closes the AGSYS 

application. Clicking on the Window’s close button in the top 
right corner of the window also closes the application. 

Baseties 

Gravity baseties are used to convert the output of the TAGS6 / 
7 gravimeter from relative to absolute gravity.  The absolute 

gravity value is needed to calculate free-air anomalies.  

Example 

The following is provided as an example. 

Before the first flight, the crew uses a relative land gravity 
meter to find the absolute gravity value at the aircraft preflight 
parking location by reference from a known gravity value. 

http://appendixd.doc/#SWTroubleshooting
http://appendixd.doc/#SWTroubleshooting
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Land gravimeter 

reading at gravity 

base station 

3730.1 Known absolute 

gravity value at 

gravity base station 

980131.4 

Land gravimeter 

reading at aircraft 

parking 

3717.2     

Difference -12.9 Calculated absolute 

gravity value at 

aircraft parking 

980118.5 

 

Still Reading 

During the survey, the aircraft is parked at the preflight parking 

location and the TAGS-6 / 7 gravimeter is read while the aircraft 
is stationary (still reading). This value is used to convert the 
TAGS-6 / 7 gravity values during the flight from relative to 

absolute gravity. Another still reading is made after the flight to 
monitor and correct for instrument drift. Refer to Table 4-1. 

 

Table 4-1 Still Reading Pre /Post Flight 

 

 

 

 

 

TAGS-6 / 7 pre-flight still reading 10567.2 

Calculated absolute gravity value at aircraft parking 980118.5 

Offset from TAGS-6 / 7 to absolute gravity 969551.3 

TAGS-6 / 7  reading during flight 9930.1 

TAGS-6 / 7 reading during flight converted to absolute gravity 979481.4 
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Baseties Menu 

The Baseties menu on the main AGSYS dialog box provides 
access to the basetie functions.  

 

Figure 4-6 Baseties Menu Options 

New Basetie 

Click New basetie under the Baseties menu (Figure 4-6) to 

create a new basetie. 

The Add New Basetie dialog (Figure 4-7) opens. Enter the 
appropriate data for the basetie location. This data is used to 
calculate the local gravity variations due to diurnal tidal effects 

and to convert relative gravity measurement to absolute 
measurements. 

Basetie location can be entered as degrees minutes seconds or 

as decimal degrees. Basetie location does not need to be 
precise; accuracy to within ± 100 meters is acceptable. 
Handheld GPS data or Google Earth are generally precise 

enough for the basetie location. For detailed Basetie function 
definitions, refer to Table 4-2.  
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Figure 4-7 Add New Basetie Dialog 

Click Add to create the baseties.mat file in the survey folder. 
This file is in MATLAB format so it cannot be created or edited 
directly using a text editor. 

Click Clear to clear the form without saving the data. 

Click Close to close the window without saving the data. A close 

confirmation dialog pop-up window requires user to confirm or 
cancel the close.  
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Table 4-2 Baseties Function Definitions 

Basetie name Free format name, used as documentation only. 

The Basetie name appears in pull-down menus in 

other parts of the program, therefore a short 

name is advised.  

Basetie value 

(milliGals) 

Absolute gravity value at the aircraft basetie 

location 

Gravity datum 

  IGSN71 Most commonly used and can be used as a 

sensible default. 

  Old Potsdam Rarely used. Usually used when data must be 

tied to an older survey. Use of this gravity datum 

STRONGLY implies use of the IGF30 gravity 

formula for the survey. 

Absolute meter Use if value was taken by an absolute 

gravimeter. 

Unknown Use if the gravity datum is unknown. 

Basetie location 

Latitude Latitude of aircraft basetie location. Can be in 

DD.D, DD MM.M, or DD MM SS.S, with (+/-) or 

(N/S) and does not need to be precise, ±100 

meters is acceptable. A hand-held GPS receiver 

location is acceptable.  

Longitude As Latitude. 

Height Orthometric (sea-level) elevation height of 

aircraft basetie location, in meters. 

Tied from Free format name, used as documentation only. 
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Edit Basetie 

Refer to Table 4-2 for the Basetie functions. Select the basetie 
using the drop down list displayed in the Select basetie 

function. The selected basetie name displays in Basetie name.  

 

Figure 4-8 Edit Basetie Dialog 
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Import Baseties 

The basetie can be imported from an existing AGSYS survey. 
Click Import basetie on the Baseties menu to import an 
existing basetie. A Specify survey directory for basetie 

import browser opens. Browse to the location of the the AGSYS 
survey folder and select the folder containing the basetie to 

import. Click OK to import the selected basetie file into the new 
survey folder. 

View/Edit Baseties 

Once a survey is selected and has an associated basetie(s), click 
View/Edit Bastie on the Baseties menu to view or edit the 
Basetie.  

IMPORTANT AGSYS does not recognize when survey, basetie or meter 
information has changed and the line data is not recomputed. If 

changes are made to the survey, basetie or meter information, 
line data must be calculated manually.  See Appendix D 

Software Troubleshooting for more information. 

Delete Basetie 

To delete an existing basetie select the Delete Basetie option 
from the Baseties menu on the main AGSYS window.  

WARNING Deleting an existing basetie may affect existing flights which use 

that basetie. 

http://appendixd.doc/#SWTroubleshooting
http://appendixd.doc/#SWTroubleshooting
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Meters 

The meter file describes one specific TAGS-6 / 7 gravimeter as 

installed in one specific aircraft. The parameters are divided into 
two groups:  

Installation parameters  

• Set by the user from the actual measurements on the 

aircraft.  

 

Gravimeters parameters 

• Set from information supplied by Micro-g LaCoste (MGL). 

• Do not change unless a new gravimeter description is 

supplied by MGL. 

• Various gravimeter parameters supply scaling factors from 

the data channels logged by the gravimeter to milliGals. 

• These parameters are initially determined in the factory 

using motion testing machines and gravity calibration range 

data. 

o They are further refined using test data taken in a 

truck driving on a gravity test range. 

o The final values are set using data from calibration 

flights on an aircraft. 

Create New Meter 

Click New meter under the Meters menu. The NewMeter6 
(Figure 4-9) dialog opens.  
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Figure 4-9 NewMeter6 Dialog 

 

Enter the reference data for the aircraft and the vertical 
distances (in meters) between the runway and the sensor and 
between the sensor and the onboard GPS antenna. Refer to 

Table 4-3 for meter parameter definitions. When finished 
entering the parameter data, click Add to create the 

meters.mat file.  

Click Add to create the meters.mat file in the survey folder.  

Click Clear to clear the entire form without saving the data. 

Click Close to close the dialog box without saving the data. A 
pop-up close confirmation dialog requires the user to confirm or 
cancel the close. 
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Table 4-3 Meter Configuration Table 

 

 

Import Meters 

The meter parameters can be imported from an existing AGSYS 

survey. From the main AGSYS dialog, select Import meters. A 
Specify survey directory for meter import browser dialog 
opens. Select the AGSYS survey folder containing the meter to 

import. Click OK to import the meter file into the new survey 
folder. 

View/Edit Meters 

Use the View/Edit menu option to make meter modifications. 
Select the meter to modify from the Select meter drop down 

list, then make the modification and click Accept to save the 
changes.  
 

IMPORTANT AGSYS does not recognize when survey, basetie or meter 
information has changed and the line data is not recomputed. If 

changes are made to the survey, basetie or meter information, 
line data must be calculated manually. See Appendix D Software 

Troubleshooting for more information. 

Meter number A 3 digit meter serial number assigned at the factory.  

Scale factor Conversion factor from gravimeter counter units (CU) to 

milliGals.  

VCC factor  VCC cross-coupling coefficient. 

VE factor VE cross-coupling coefficient   

LACC2 factor LACC2 cross-coupling coefficient (for experiment) 

XACC2 factor XACC2 cross-coupling coefficient (for experiment) 

Installation Parameters 

Aircraft Free format name, used as documentation only (often the 

aircraft registration code). 

Runway to sensor (m) Height from runway to gravity sensor in meters (located at 

intersection of platform gimbal axes). 

Sensor to GPS (m) Height from gravity sensor to base of GPS antenna in 

meters. 

http://appendixd.doc/#SWTroubleshooting
http://appendixd.doc/#SWTroubleshooting
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Delete Meters 

To delete an existing meter select Delete meter from the 
Meters menu on the main AGSYS window.  

WARNING Deleting an existing meter may affect existing flights which use 

that meter. 

Terrain Corrections 

The Terrain Corrections menu option provides two utilities 

(Terrain Correction Grid and Expand LatLong Box) to assist 
in terrain correction calculations which should be completed 

prior to conducting the field survey. Create the survey folder 
then calculate the regional and local terrain corrections for the 
survey. Refer to Section 09 for detailed instructions.  

Flights And Lines 

Once the survey, baseties and meters configurations are 

complete the Flights and Lines menus are used to process the 
gravity data. See Sections 06 and Section 08 for detailed 

instructions.  

http://section09.doc/
http://section06.doc/
http://section08.doc/
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AGSYS Data Processing Steps Overview 

Terrain Corrections 

Refer to Section 09 for terrain correction instructions. This step 
is optional and may be done at any time in the processing flow. 

On Terrain Correction menu: 

● Determine the Latitude/Longitude bounds of the survey area 

(or import the bounds from the processed survey data). 

● Calculated the Latitude and Longitude of an extended local 

and regional survey area using the Expand Lat/Long Box 

utility. 

● Copy the calculated values and then paste them into the 
data retrieval engine used at your site. Refer to Section 09 

for some possible topographic data sources.  

● Create a Terrain Correction folder under the AGSYS Survey 

folder containing the regional and local terrain grids  

● Input the regional and local terrain grids into the AGSYS 

Terrain Correction Grid utility and calculate the terrain 

correction grid.  

Survey Setup  

Refer to Section 04 for AGSYS detailed instructions.  

● Open an existing or create a new survey. 

● Calculate the regional and local terrain corrections (if 

desired). 

● Enter or import a Basetie and Meter.  

o There must be at least one Basetie and one Meter per 

survey. 

o A survey may have multiple Baseties and Meters. 

Flight Data Processing 

Refer to Section 06 for AGSYS detailed data processing 

instructions. 

http://section09.doc/
http://section09.doc/
http://section04.doc/
http://section06.doc/
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● Download the raw gravity and GPS data files from both the 

aircraft and base station system to the data processing 

system.  

● Create a new flight. 

● Select the active flight using the Set active flight command. 

● Load the raw field gravity. 

● View the raw gravity data (optional). 

● Load Master and Remote field GPS data.  

● View raw GPS data (optional). 

● Run GrafNav (Refer to Section 07 for detailed GrafNav 

processing instructions.) 

o Connect Waypoint GrafNav/GravNet license key to the 

processing computer. 

o Convert raw GNSS data to GPB files. 

o Add Master and Remote GNSS Data files. 

o Process GNSS Differential. 

o Plot results (optional). 

o Export data to file. 

 

Line Processing 

Refer to Section 08 for AGSYS line processing instructions. 

● Create a new line with unique line number, using the flight 

operator’s log and selected data traces to define each flight 

line. 

● Process a line or all lines. 

● Apply the terrain corrections to a specific line or all lines.  

● View processed data. 

● Export processed line data to a Microsoft Excel® format or a 

CSV file. 

http://aerogravwithsection07.doc/
http://section08.doc/


 

6. FLIGHT DATA PROCESSING  

Raw Data Storage Size ........................................................................... 6-1 
Download Files ...................................................................................... 6-1 

Raw Gravity and GPS Data Files ............................................................ 6-1 
Still Readings ..................................................................................... 6-2 
Operators Log .................................................................................... 6-2 

Flights ................................................................................................. 6-2 
Create New Flight ............................................................................... 6-2 
Set Active Flight ................................................................................. 6-5 
View/Edit Active Flight ......................................................................... 6-5 
Flight Data Utilities .............................................................................. 6-5 
Set Active Flight From Line ................................................................. 6-11 
Delete Active Flight ........................................................................... 6-11 

 

 

 
 

 
 
 

 
 
 

6
. F

lig
h

t D
a
ta

 P
r
o

c
e
s
s
in

g
 

 



 
 

 

 
 



 

Flight Data Processing  6-1 

Release 115-780-007B, Release Date 15 Oct 2024 

Raw Data Storage Size 

 Total raw data file size is about 6.7 megabytes/hour. 

• Gravity: 720 kilobytes/hour 

• GPS / GNSS: approximately 3 megabytes/hour per receiver 

o Total 6 megabytes/hours for both master and remote 

Total processed data size is about 19 megabytes/hour. 

Grand Total raw data files size plus processed data size is about 

26 megabytes /hour. 

Download Files 

Refer to Appendix A to view a short sample output data file.  

Raw Gravity and GPS Data Files 

Download the raw gravity and GPS / GNSS data files from both 

the aircraft and the base station systems to the data processing 
system. It is important to label and track the source location of 
these files, as well as to keep archive copies.  

The TAGS-6 / 7 meter outputs the raw gravity data (20 Hz 

sampling rate) (*.txt files) from the meter. The filename is 
operator specified. Only one file is created for the entire flight. 

Refer to the TAGS-6 / 7 PiperPro Processing Software Manual for 
additional information. 

The GPS / GNSS files names are of the form number.pdc (*.LOG 
for PWPK7 receivers). The number is automatically generated 

from the receiver serial number and the date. The file is in 
binary format. It is important to clearly label the aircraft 

(Remote) GPS / GNSS file vs. the base station (Master) GPS / 
GNSS file. Saving the files into different folders named to 
indicate Master or Remote is a good way to do this. If they are 

processed through GrafNav incorrectly identified, it becomes a 
difficult manual process to correct the problem.  

about:blank
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IMPORTANT Clearly label and copy the aircraft field GPS / GNSS data files 
into AGSYS as the Remote file and the base station field GPS 
data files as the Master. 

  You can use the steps found in Appendix D Software 

Troubleshooting to check that the Master (base station) and the 
Remote (aircraft) GPS / GNSS data was correctly copied into 
AGSYS. Do this check before processing the data through 

GrafNav. 

Still Readings 

It is recommended that the operator generate two screen dump 
files in .bmp format of the before and after flight still readings. 

Generating a clearly-named TAGS6 / 7 data file for each still 
reading is also highly recommended. 

The location of the raw files on the AGSYS processing system is 

site dependent.  

Operators Log 

It is recommended that a copy of the operator's log file also 

accompany the data. It contains survey information necessary 
for processing. 

Flights 

Before configuring flight options, the Survey, Basetie and Meters 
configurations must be completed. A survey can have multiple 

Baseties and Meters. This enables a large survey to utilize 
multiple meters, aircrafts and airports. A flight can have one or 

two Baseties (but only one meter), so that a flight can take off 
from one location and land at another.  

The raw gravity and GPS data are loaded into AGSYS using 
commands on the Flight menu.  

Create New Flight 

Click New flight on the Flights menu to open the Add New 
Flight dialog (Figure 6-1). Refer to Table 6-1 for detailed 

information on each of the parameters to be configured. Click 
Add when configuration is complete. In the Continue add pop-

up, click yes to add another flight, click no to exit.  

http://appendixd.doc/#SWTroubleshooting
http://appendixd.doc/#SWTroubleshooting
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Figure 6-1 Add New Flight Dialog 
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Table 6-1 Flight Parameter Configurations 

Flight number Unique flight number (integer) for the survey. 

Gravity meter The 3 digit official serial number assigned at the factory which is in the 

format S-XXX. It is automatically read from the Meter number 

parameter in the meters file and pre-pended with the letter “S”. Use 

the dropdown list to select when multiple meters are configured. 

Pre-flight still reading / post-flight still reading 

Values for the following parameters can be obtained from the before and after flight still 

readings screen shots files and the flight log or from the digital data files using the 

AirSeaDataPlotter program.  

NOTE: All times and dates MUST be in UTC time. 

Date Use Calendar to select the reading date, or enter by hand. Several 

different formats can be used, but the least ambiguous is 

ddmmmyyyy (’03-NOV-2015’ for November 3, 2015).  

Time Enter the reading time in hours:minutes. 

Basetie Use the dropdown list to select a basetie if multiple baseties are used 

in the survey. 

Meter gravity Enter the value of the filtered gravity (mGals) for the still reading.   

Output gravity 

filter: (seconds) 

The output gravity filer is a balance between resolving power and the 

introduction of too much noise in the signal. Set the output gravity 

filter based on the speed of the aircraft and the desired resolution. 

The filter is defined by the half period/half amplitude point.  

For example, if the aircraft is flying at 60 ms-1 and a filter of 100 

seconds is used then an anomaly which is 6km wide would be 

attenuated by ½. 

Example settings: 

● Smooth flight = 80 seconds 

● Normal flight with little turbulence = 100 seconds 

● Highly turbulent flight = 120 seconds or more 

Takeoff / Landing  

These date/time values can be obtained from the operators’ log file. AGSYS will ignore 

gravity and GPS data which falls outside the takeoff/landing time range. 

NOTE: The operator must ensure that the Takeoff and Landing time are noted in the 

Operator’s log in UTC time. If no date/time has been logged, the Takeoff time can be set 10 

minutes prior to the first line start time and the Landing time set 10 minutes after the last 

line end time. 

Date 

Time 

Use Calendar to select the takeoff/landing date. 

Enter the takeoff/landing time in hours:minutes. 
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Set Active Flight 

To select a flight, select the Set Active Flight option under the 
Flights menu. The Flights popup (Figure 6-2) lists all the 
flights associated with the current survey. The selected flight 

becomes highlighted when clicked on. Click Accept to make the 
selected flight active or click Cancel to close the window 

without choosing a flight.  

 

Figure 6-2 Flights Pop-up 

View/Edit Active Flight 

Once a flight is active, the View/edit active flight opens the 
Edit Flight window. Parameters for the selected flight can be 

viewed and/or modified. Click Close to make no changes or 
Click Accept to accept the modifications. 

After setting the active flight use the Flight data utilities to 

load field gravity and GPS data.  

Flight Data Utilities 

There are seven steps listed with the Flight data utilities 

command on the Flights menu. Refer to Table 6-2 for 
description of each step. To import the raw gravity and GPS 
data, execute each step in the order listed.  

IMPORTANT The WayPoint USB license key must be attached or a valid 

license activated before running GrafNav.  
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Table 6-2 Flight Data Utilities 

Utility Steps Description 

Load field gravity Used to import the raw gravity files (.txt files). 

View raw gravity Used to display the raw gravity data. Select from the trace list 

to display the raw gravity data.  

Copy field GPS Select either Master or Remote.  

Run GrafNav Starts the Waypoint GrafNav GPS post processing software. 

Refer to Section 07 for further instructions. 

View Raw GPS Select either Master or Remote. 

View processed GPS Used to display one or more user selectable channel views of 

the Waypoint process GPS data.  

View merged Grav/GPS Used to display one or more user selectable channel views of 

the Waypoint GrafNav processed merged Gravity and GPS data.  

 

Load field gravity 

On the Flights menu point to Flight data utilities and click 
Load field gravity.  

 

When the Select MGL raw gravity files browser selection 

dialog opens, select the folder containing the raw gravity data 
files.  

 

     Highlight the file and click Open.  

 

     Load only the .txt files. 

• Click OK when the data has finished loading. 

 

View raw gravity 

After loading the raw gravity data files, the data can be viewed 
by clicking on the View raw gravity. This launches the 

ChannDisp6 dialog (Figure 6-9). Select the traces to be viewed 
by selecting on one or more traces. Use the typical windows 
selections methods like CTRL-click and SHIFT-click to select 

multiple traces.  

http://aerogravwithsection07.doc/
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Figure 6-9 ChannDisp6 Dialog 

 

The data is plotted in the graph in the left panel of the Channel 
Display window. The trace selection list is displayed in the 
selection box in the right panel of the dialog. The selected flight 

number is displayed above this selection box. Refer to 
Appendix C, Table C-1 for descriptions of the raw gravity data 
trace selection list.  

The Filter is set to zero (unfiltered), the default filter length. 

The plotted data is updated as Filter value (in seconds) is 
changed in the text box at the bottom of the Channel Display 

window shows the date/time and GPS time of the data point as 
the cursor is moved across the plotted line. 

The Channel Display graphic control icon tool bar shows many 
icons. The zoom, pan and data cursor controls are 

recommended for use. The controls labeled in red in Table 6-3 
are not designed for the type of plots in AGSYS. Use them at 
your own discretion. You may encounter unexpected results. 

Click on the icon to use the feature and to toggle the feature on 
or off. Activate the feature, then right-click in the plot area to 

access additional feature commands. Refer to Table 6-3 for icon 
graphic feature description.  

http://appendixc.doc/
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Table 6-3 Channel Display Graphic Features 

File The Channel Display window File menu options:  

● Open – Opens a standard file selection dialog to view previously saved 

figures. 

● Close – Closes the Channel Display window. 

● Save – Saves the plot in a graphics file. By default, files are saved in the 

project folder. 

● Save as – Opens a standard file selection window to select save filename 

and location. 

● Export Setup 

● Print Preview 

● Print 

Control Icons: 

Open File Open a saved graph. (*.fig) 

Save Figure Save displayed figure. Refer to the Print Function section below to save the 

displayed figure to a file. 

Print Figure Open a print view of the graph(s) in Channel Display window. Refer to the 

Print Function section below for print instructions. 

Zoom In/Out Click on the zoom icon to toggle on/off the zoom in/out capabilities. Click 

and hold while moving the cursor to set zoom area. Right click on the 

graph to display following additional zoom options. 

● Reset to original view 

● Unconstrained zoom (2D plots only) 

● Horizontal zoom (2D plots only) 

● Vertical Zoom  

Pan Click on the hand tool icon to toggle this feature on or off. Use the tool to 

grab and pan over the data. Right click on the graph to display following 

additional pan options. 

● Reset to original view 

● Unconstrained Pan 

● Horizontal Pan (Applies to 2D plots only) 

● Vertical Pan (Applies to 2D plots only) 

Rotate 3D Rotates displayed graph. 

Data Cursor Click on the data cursor icon to turn this feature on. Then click on the plot 

to view the specific X:Y coordinate points in the data. Click on the data 

cursor icon again to turn this feature off.   

Insert 

Colorbar 

Inserts colorbar for the displayed graph. 

Insert 

Legend 

Inserts legend for the displayed graph. 
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Print Function 

Using the toolbar print or disk icon or the File menu print option 
creates images with known MATLAB bugs. Ghostscript is the 
recommended application as an interpreter/renderer of the data 

plots. Refer to Section 02 for Ghostscript download link. 

To save the displayed plot: 

• Deselect all tools on the toolbar. 

• Press the s or f key. 

o Opens the Save to plot file browser.  

o Select location for the plot.  

o Use the Save as type to select saved file format (pdf, eps, 

png, tif, jpg, bmp).  

Set Marker Lines 

To set marker lines on the data traces: 

• Make sure no tools on the toolbar are selected 

• Click left mouse button in the graph to place a marker line. 

• Click right mouse button to delete an existing marker line. 

 

Copy Field GPS 

• Use the Copy field GPS command from the Flight data 
utilities on the Flights menu, to download the both the 

Master and Remote GPS data (.pdc files) to AGSYS.  

• Select the Master GPS data (Base Station GPS data) to copy.  

• In the Select raw GPS master file selection dialog, open the 
folder containing the GPS data files and highlight the 

appropriate file.  

o Click Open and wait.  

o Do not click OK while it displays message “Coping Master 

station raw pgs…”. Wait until the message text changes 

to “Coping Master station raw gps…Done!” is displayed. 

o  Click OK.  

about:blank
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With Waypoint version 8.40 or greater the WConvert utility to 
convert from Novatel .pdc (or *.LOG) data format to Waypoint 

.gpb format cannot be called automatically. The copy is 
complete but a Warning Dialog (Figure 6-10) notifies users 
that the conversion does not happen until the Run GrafNav step 

is executed. 

Repeat the same steps to copy the Remote (Aircraft GPS data). 
When both the Master and Remote GPS data files have been 

loaded continue to the next step. 

Figure 6-10 Warning Dialog: Convert .pdc to .pgb in GrafNav 

 

Run GrafNav 

Refer to Section 07 for detailed instructions for running GrafNav. 
After processing in GrafNav is complete return to the Flights 

menu to view GPS data. 

View Raw GPS 

After loading the raw GPS data files, they can be viewed by 

pointing to the View raw GPS command from the Flight data 
utilities command on the Flights menu. Click either Master or 
Remote. This launches the Waypoint GPBView utility.  

View Processed GPS 

The View Processed GPS command is used to display one or 

more user selectable channel views of the Waypoint processed 
GPS data. Click View Processed GPS from the Flight data 
utilities on the Flights menu. From the ChannDisp window 

one or more traces view can be selected. See Table 6-3 for 
description of the graphic features.  

http://section07.doc/
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View Merged Grav/GPS 

Click View merged grav/GPS from the Flight data utilities 
on the Flights menu. From the ChannDisp window one or 
more traces view can be selected. See Table 6-3 for description 

of the graphic features. 

Set Active Flight From Line 

After lines have been configured, the active flight can be 

optionally be set by using the Set active flight from line 
command under the Flights menu.  

The popup window lists all the lines associated with the current 

survey. Selecting a specific line from this list activates the 
associated flight. To use this command, click on the Set active 
flight line command on the Flight menu. In the 

Flightfromline dialog highlight the desired line number and 
click Select. In the main AGSYS dialog box the Flight name 

shows the active flight number for the line selected. 

Delete Active Flight 

To delete a flight, it must be active. Click Set active flight on 

Flights menu. In the Flights dialog box, select the flight you 
wish to delete and click Accept. Then click Delete active flight 
on the Flights menu and click Yes in the deletion confirmation 

window.  
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GrafNav  

Before launching GrafNav, the following remote flight data 
utilities must be completed. Refer to the “Flight Data Utilities” in 

Section 06.  

• Load field gravity 

• Copy field GPS: Master 

• Copy field GPS: Remote  

The Run GrafNav utility is located under the Flight menu. Be 
sure the Waypoint GrafNav/GrafNet license key is attached to 

the processing computer before selecting Run GrafNav. 

NOTE This menu selection is the only way to force a re-merge of the 
gravity data with the GPS data if the flight definition or raw 

gravity data has been changed. 

If GrafNav is rerun, a re-run GrafNav confirmation dialog (Figure 

7-1) appears. Click Yes to re-run GravNav with existing 
processed GPS data and proceed to the File conversion step. 

If click No, existing file is processed.  

 

Figure 7-1 re-run GrafNav Confirmation Dialog 

http://section06.doc/#FlightDataUtilities
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TAGS6_84 - GrafNav 8.40 Main Window 

Figure 7-2 TAGS6 84 - GrafNav 8.40 Window 

IMPORTANT Connect the Waypoint GrafNav/GrafNet™ license key to the processing 

computer (for version < 8.70). If the Waypoint GrafNav/GrafNet 
license key is not connected most GrafNav functions will not be 

available. 

File Conversion 

In the main GrafNav window (Figure 7-2) from the File menu, 

Convert option list, select the Raw GNSS to GPB option. 
Configure the conversion setup options in the Convert Raw 

GNSS data to GPB dialog (Figure 7-3). 
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Figure 7-3 Convert Raw GNSS Data To GPB Dialog 

• In the Receiver Type section, select NovAtel 

OEM4/OEMV/OEM6 then click on the Global Options 
button which opens the NovAtel OEM4/OEMV/OEM6 

Options dialog (Figure 7-4). 

o In the General section: check the Perform pre-

processing checks and Re-compute position and 

clock offset boxes.  

o In the Static/Kinematic Mode section, select 

Kinematic then click OK. 

• In the Folder section of the Convert Raw GNSS data to 
GPB dialog, set the path to the raw file folder. This path will 

be <Survey folder>\<Flight number>\GPS. 

• Both the master.pdc and the remote.pdc file are displayed 

in the Source Files section. Click the Auto Add All button. 

Both files should move over to the Convert Files section.  

• Click Convert.  

o A Converting NovAtel OEM4/OEMV/OEM6 to GPB dialog 

shows conversion process log. 
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o Wait until the Conversion Complete dialog displays 
showing 2/2 files succeeded (Figure 7-5). Then click 

Close. 

• The Convert Raw GNSS data to GPB dialog, Convert 

Files section now shows check marks next to the converted 

files instead of an icon. Click Close. 

 

Figure 7-4 NovAtel OEM4/OEMV/OEM6 Options Dialog 

 

Figure 7-5 Conversion Complete (2/2 files succeeded) 
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Add Master/Remote Files 

• In the main GrafNav window (Figure 7-2), select Add 

Master File(s) under the File menu.  

• In the Add Master GNSS Data File(s) dialog (Figure 7-6), 
navigate to the folder containing the converted files (the 
browser should open in this folder) and highlight the 

master.gpb file and click Open. 

• The File section displays the path to the master.gpb file.  

• In the Coordinates section click on the Select From 

Favorites button to select the base antenna station location 

and click Select station. 

• In the Add Master GNSS Data Files(s) dialog the selected 

station configuration is then displayed. Click OK. 

NOTE If the GPS base antenna station has not yet been configured, 
click the Favorites Manager button. In the Favorites 
Manager dialog click Add Site. In the Add Station dialog, 
enter the Name and station properties. Then return to the Add 

Master GNSS Data File(s) dialog and click the Add to 
Favorites button.  

 If for some reason the base station antenna location has not 

been established (NOT RECOMMENDED), you can select the 
“Use Average Position” button as a temporary solution. Note 
that if a precise base station position is established later, GPS 

and gravity data processed using the average position must be 

reprocessed using the precise location. 
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Figure 7-6 Add Master GNSS Data File(s) Dialog 

• In the main GrafNav window, select Add Remote file under 

the Files menu.  

• In the Select Remote GNSS Data File dialog in the 
Remote file name select the remote.gpb file then click 

Open. 

• In the Antenna Height section of the Select Remote 

GNSS Data File dialog (Figure 7-7): 

o Make sure the Remote file name points to the 

remote.gpb file.  

o Make sure the Use simple vertical antenna height (to 

L1 phase centre) is selected.  

o Leave the Vertical Antenna height as 0.000. 

o Click OK. 
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Figure 7-7 Select Remote GNSS Data File Dialog 

 

Process GNSS Differential 

Under the Process menu select Process GNSS or click on the 
aircraft icon  

 

• In the Process GNSS dialog (Figure 7-8): 

o In the Processing Method section, select Differential 

GNSS option. 

o In the Processing Direction section, select Both.  

o Click Process. 



 
 

7-8  GrafNav/GrafNet Processing 

 Release 115-780-007B, Release Date 15 Oct 2024 

 

Figure 7-8 Process GNSS Dialog 

 

• A processing window appears (two windows if your computer 

is a multiprocessor), wait until processing is complete. 

o Watch the Quality Factor value during processing (Figure 

7-9). The Quality Factor value range should be mostly 1 

or 2. 

o If Quality Factor value is in the four to six range then 

consult the WayPoint documentation.  

o Optional: When processing is complete, the Quality Factor 
summary can be viewed by clicking Processing 

Summary on the View menu.  
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Figure 7-9 Unprocessed Map And The Processing Differential Forward / Reverse Dialogs 

 

Plot Results 

     To plot the results: 

• Select Plot Results from the Output menu or click on the 

Plot Results icon.  

 

• In the Plot Results dialog (Figure 7-10), click on the Select 

Plot tab. 

o Open the Quality Control folder. 

o Recommended viewing includes the Quality factor and 
the Number of satellites (Line) (Figure 7-11). Click OK 

to plot. 

 

Quality 
Factor 
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o Figure 7-11 shows an example of the Number of 

satellites (Line) plot. 

 

Figure 7-10 Plot Results Dialog 
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Figure 7-11 Plot Number Of Satellites 

 

Export Data To File 

• Click Export Wizard on the Output menu to export the 

data to a file or click on the export icon.  

 

• In the Export Coordinates Wizard dialog (Figure 7-12) the 
TAGS-6 position must be selected in the Profile section. 

Click Next. 

• In the Select Output Coordinate Datum dialog (Figure 7-
13) select the default settings (Use processing datum 

WGS84). Click Next. 

• In the Geoid Correction dialog (Figure 7-14), point to the 
EGM96-World geoid (or other geoid model as specified in 

the survey requirement). Click Next. 

• In the Select Epoch Sampling Mode dialog (Figure 7-15), 
select the Export every epoch in the Sampling Mode 

section. Click Next. 
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• In the Export Definition Complete dialog (Figure 7-16), 
check the View ASCII output file on completion box, 

then click Finish.  

IMPORTANT Do not alter any of the Export fields. 

• Close the TAGS6_84 - GrafNav 8.40 window. Click Exit 

under the File menu.  

• Wait for series of pop-up messages describing the gravity 
related GPS calculations and the gravity/GPS data merge. 
Note that the gravity data is time shifted to GPS time from 

the logged UTC time. The final pop-up message is: GPS / 

Grav merge complete!!! (Figure 7-17). 

 

Figure 7-12 Export Coordinates Wizard Dialog 
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Figure 7-13 Select Output Coordinate Datum Dialog 

 



 
 

7-14  GrafNav/GrafNet Processing 

 Release 115-780-007B, Release Date 15 Oct 2024 

 

Figure 7-14 Geoid Correction Dialog 
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Figure 7-15 Select Epoch Sampling Mode Dialog 
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Figure 7-16 Export Definition Complete Dialog 

 

 

Figure 7-17 GPS / Grav Merge Complete Pop-up 
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Lines 

Define each flight line after all the flight GPS and gravity data 
has been uploaded and configured. Each line is a distinct block 

of time. A bad start/end time pop-up error message window 
displays when the line start/end overlaps with another line.  

New Line 

Click New line on the Lines menu to open the LinePick dialog 
(Figure 8-1). By default the "lacc" (long-axis accelerometer), 

“OnLine”, “ve” (East velocity) and “vn” (North velocity) channels 
are displayed. Any previously defined lines are displayed as 
shaded areas on the displayed channels. 

 

Figure 8-1 LinePick Dialog 

Select one or more channels to display by using the standard 

Windows selections methods like SHIFT-click or CTRL-click to 
select multiple channels. See Appendix C for a table of AGSYS 
Channels. 

http://appendixc.doc/#AppendixC


 
 

8-2  Line Data Processing 

 Release 115-780-007B, Release Date 15 Oct 2024 

To set a new line, enter a unique line number in the text box 
located above the channel list. 

There are three white text boxes at the bottom of the LinePick 

window. The middle text box displays the date, time and 
coordinate point of the current mouse cursor position. The 

information updates as the cursor position changes.  

Using the flight operator log together with the Online, ve 
(Velocity East) and vn (Velocity North) channels, determine the 
line start and end points. Use the Zoom In icon to expand the 

selected view area. Click and hold right mouse while dragging 
the zoom cursor. A rectangular box is drawn showing the 
selected zoom area. Right click anywhere in the display and 

select Reset to Original View from the command list. Click the 
Zoom In icon to toggle zoom on/off.  

Place the cursor at the line start location and click the left 

mouse button. A green line displays and the left text box 
displays the date, time and the coordinates of the start line.  
Place the cursor at the line end location and click the right 

mouse button. A red line displays and the right text box displays 
the date, time and the coordinates of end line. Adjust the line 
start or line end by holding down the appropriate mouse button 

and dragging the line. Release the mouse button to place the 
line.  

The line start should be picked after the Online channel is on 

(value 1), and the aircraft velocity and course (as shown by the 
ve and vn channels) are approximately constant. The lacc (long-
axis accelerometer) channel can also be used to see when the 

gravity meter stabilized platform has come close to re-leveling 
after the turn: this can be recognized as the end of a long 

period recovery signal in the lacc channel. 

The line end should be picked before the Online channel is off 
(value 0), and the aircraft velocity and course (as shown by the 
ve and vn channels) show changes as the aircraft maneuvers to 

the start of the next line.  

When satisfied with the location of the line start and end times, 
click Accept to save the line and close the window. Refer to 
Figure 8-2 

Repeat this procedure for all the flight lines.  
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    To exits the LinePick dialog without saving changes: 

     Click on the upper right corner close window icon.    

     Select Close under the File menu.  

 

Figure 8-2 LinePick Dialog: Example Line 10010 

 

View / Edit Line 

To view or edit an existing flight line, select the line number 

from the drop down list in the View /edit line option under the 
Lines menu. The LinePick dialog opens and by default the lacc, 
OnLine, ve and vn channels are displayed.  

The shaded areas in each display show the location of all the set 

lines.  

• The text box above the channel list shows the selected line 

number.  
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• The date, time and GPS locations for the selected line is 
displayed in the left (Line Start) and right (Line End) text 

boxes at the bottom of the LinePick window.  

• The middle text box gives the date, time and GPS location of 

the current cursor position and updates as the cursor moves. 

Refer to Figure 8-3. 

 

Figure 8-3 Example View/Edit Line 10030 

 

To display one or more data channels use the typical windows 
selections methods like SHIFT-click or CTRL-click to select 
desired channels.  

Use the right mouse button to change the start line location 

(Green Line) and use the left mouse button to change the end 
location (Red Line). Clicking and dragging the start or end line 

works exactly the same as when defining a new line. 

An error message displays if the start or end line overlaps 
another existing line. Click OK to close the error message box. 
Use drag and drop to move the start/end line. 
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 Click Accept when satisfied with the modified line start/end 
points.  

     To exit the LinePick dialog without saving changes: 

     Click on the upper right corner close window icon.  

     Select Close under the File menu. 

Process 

After all the lines have been set, select Process on the Lines 

menu and click on a specific line number or click on All Lines to 
process all the lines.  

An information pop-up box appears with “gravity time shift 
x.xxx sec". The number should stay constant to within 0.050 

seconds for all lines of the survey flight. If this number changes 
between lines by more than 0.050 seconds, go back and review 
the data. Check your company policy to determine when a re-fly 

is required or eliminating the skewed data spot is appropriate. 

After the line has been processed, AGSYS opens a ChannDisp 
window with the FAA (Free-Air Anomaly) channel displayed. The 

default Filter length displayed gets its value from the Output 
gravity filter field on the Editflight Dialog box. (Refer to 
Section 06 “View/Edit Active Flight” section)  

Once processed, the line number is followed by an asterisk in 

the Process line list (Figure 8-4). 

NOTE AGSYS does not recognize when survey, basetie or meter 
information has been changed. If changes were made after line 

data has been processed, all lines must be re-computed. 

http://section06.doc/


 
 

8-6  Line Data Processing 

 Release 115-780-007B, Release Date 15 Oct 2024 

 

Figure 8-4 AGSYS Process Line 

 

View Processed Data 

Once the lines have been processed they can be viewed using 
the View Processed Data option (Figure 8-5). From the line 

selection list, select a processed line (line number with an 
asterisk) to view. The FAA (Free-air Anomaly) channel trace 
is the default view.  

Select one or more channel traces to display by using typical 

windows selections methods like SHIFT-click or CTRL-click to 
select desired channels.  

The text box at the bottom of the ChannDisp window (Figure 
8-5) shows the date, time and GPS coordinates of the current 

cursor location. As the cursor moves, the information is 
updated.  
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Figure 8-5 View Processed Data Showing a Marker 

 

One or more markers can be placed on the channel data plot 
(Figure 8-5). First position the cursor on the channel data plot. 

Then click the left mouse button to place each marker.  

A marker can also be placed by dragging: click and hold the left 
mouse button to drag the marker and release the mouse button 

to place the marker in the changed location.  

To delete a marker, position the cursor near the marker and 
click the right mouse button. The marker closest to the cursor 
will be deleted.  
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Apply Terrain Corrections 

Apply terrain corrections after the lines have been processed. 
Refer to Section 09, Terrain Correction Grid for instructions 
on how to create the terrain correction grid file needed by the 

Apply Terrain corrections utility.  

Select Apply terrain corrections from the Lines menu (Figure 
8-6). Click on a specific line or click All lines. In the Terrain 

effect grid browser, navigate to the terrain corrections data 
folder and select the Terrain Correction Grid output file and 
click Open. To view the terrain correction traces (Terrain 

Effect or Bouguer Anomaly), from the Lines menu, click on 
View processed data.  

 

 

Figure 8-6 Lines: Apply Terrain Corrections 

http://section08_081709.doc/#Sec8TerrainCorrectionGrid
http://section08_081709.doc/#Sec8TerrainCorrectionGrid
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Export Processed Line 

From the Lines menu, select either Export processed line 
(XLS) or Export processed lines (CSV) (Figure 8-7), then 
either select a specific line number or All lines to export to a 

Microsoft Excel® (XLS) format or to a comma-separated-value 
(CSV) format.  

 

 

Figure 8-7 Export Process Line 
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If exporting a CSV file, the Seg headers (designed for input to 
the Generic Mapping Tools (GMT) package) dialog box (Figure 8-

8) appears asking if segment headers should be written to the 
file. Click Yes or No to include/not include the segment headers 
in the CSV file.  

 

 

Figure 8-8 Segment Header Dialog Box 

 

In the CSV export file or Excel export file browser (Figure 8-

9) create or select a destination folder and specify the filename 
for the export file. If the filename already exists, a "file already 
exists" message window requests overwrite confirmation.  

 

 

Figure 8-9 Excel or CSV Export File Browser 
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In the Click on right arrow to reload dialog (Figure 8-10), 
click to select channels from the Available channels list, then 

click on the right arrow to move the selected channels, to the 
Channels to export list. Use the left arrow to remove the 
selected channels from the Channels to export list. Click OK 

when channels have been selected.  

The selection list for this flight is remembered between runs of 
AGSYS and are automatically highlighted so they can be 

reloaded in one step by clicking on the right arrow. 

 

 

Figure 8-10 Click On Right Arrow To Reload Dialog 
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Once channels have been selected the Select channels for 
filtering dialog (Figure 8-11) enables the output gravity filter 

specified in the flights Output gravity filter to be applied. Use 
the right and left arrows to select or deselect channels for 
filtering. Click OK to execute the export.  

 

 

Figure 8-11 Select Channel For Filtering Dialog 
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During processing, an export status is displayed (Figure 8-12). 

 

Figure 8-12 Export Processing Status 

 

If a previous export was completed and the set of export 
channels are the same, the previous filter selection is 

highlighted in the Export channels frame and can be quickly 
reloaded by clicking on the right arrow.  

Each exported line is saved to its own sheet in the Excel file. 

The Excel sheet name is the line number prefixed with "L".  

Delete Line 

To remove a line, use Delete Line to select the line number to 

remove. In the confirmation window, click Yes to confirm the 
deletion. Click No to return to the main AGSYS dialog box.  
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The Terrain Corrections menu provides two utilities to assist 
in calculating terrain corrections. The Expand LatLong Box 

utility calculates an extended latitude/longitude area by a given 
distance outside of the survey area for use with DTM (Digital 
Terrain Model) data retrievals. The Terrain Corrections Grid 

utility calculates terrain corrections from DTM local and regional 
grids.  

Completing calculations for the combination of local 

(latitude/longitude bounds of the survey area usually extended 
as determined by the surrounding geographic area, often 20 
km) and regional (survey area usually extended by 170 km) 

grids is recommended.  

The Terrain Correction Grid utility first calculates the coarsely 
sampled regional corrections which include terrain effects well 

beyond the survey area (such as mountains or oceans) and then 
makes short-wavelength corrections based on the detailed local 
grid, which account for nearby terrain effects in and near the 

survey area. While it is possible to use just local or just regional 
corrections, using both the regional and local corrections adds 
significant value to the terrain corrected data and is highly 

recommended. Generally, the regional terrain grid will have a 
grid spacing of 1-2 km, while the local grid will be at 100-200 

meter grid spacing.  

Topographic Data Sources 

There are a large number of possible sources for the 
topographic data needed for gravity terrain corrections. MGL has 
collected a small list of public-domain data sources available on 

the Internet. 

1. https://www.earthdata.nasa.gov/sensors/srtm  This site 

allows you to search and download SRTM data 

2. http://www.gebco.net/:  General Bathymetric Chart of the 
Oceans (GEBCO). This site provides 1 arc-minute (~1 km) 

resolution bathymetry data, as well as a 30 arc-second 

(~500 meter) merged bathymetry / terrain (SRTM) dataset. 

3. http://topex.ucsd.edu/WWW_html/mar_topo.html: Satellite 
Geodesy Group, Scripps Institution of Oceanography. The 
emphasis here is on deep-ocean bathymetry derived from 

satellite radar altimetry, merged with SRTM data on land. 

http://www.gebco.net/
http://topex.ucsd.edu/WWW_html/mar_topo.html
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4. http://www.ngdc.noaa.gov/mgg/bathymetry/relief.html: 
United States National Oceanic and Atmospheric 

Administration (NOAA) / National Geophysical Data Center 
(NGDC). This site provides global ETOPO1 1-arc-minute (~1 
km) resolution merged terrain and bathymetry data, as well 

as several other global and US-specific datasets. 

5. http://www.marine-geo.org/portals/gmrt/: Marine 
Geoscience Data System (MGDS) / Global Multi-Resolution 
Topography (GMRT). GMRT is a global ~100 meter resolution 

merged terrain/bathymetry dataset. 

Data availability and quality for a given area may vary between 

sources, so checking multiple sources is generally a good idea. 

The “Expand LatLong Box” utility in AGSYS facilitates working 
with the retrieval pages for these (and other) sites, which are 

designed to download data within specified latitude/longitude 
bounds. 

After retrieving the data, there are two other steps which are 
generally required: 

1. Projecting the downloaded data from lat/long to grid 

coordinates in the UTM zone specified for the AGSYS survey  

2. Converting the data from the downloaded format into a grid 

format readable by AGSYS (Geosoft .grd or GMT NetCDF). 

AGSYS does not provide the tools needed for these steps. 
Internally, MGL uses the relatively inexpensive Global Mapper 
program, available from http://www.globalmapper.com/, as a 

tool for working with topographic datasets. Global Mapper can 
read a wide variety of grid formats, project to UTM, and output 
Geosoft .grd format file. 

http://www.ngdc.noaa.gov/mgg/bathymetry/relief.html
http://www.marine-geo.org/portals/gmrt/
http://www.globalmapper.com/
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Expand LatLong Box 

The Expand LatLong Box utility calculates the Latitude and 
Longitude of an extended survey area. It is recommended to do 

this calculation as soon as the survey bounds are known so the 
terrain calculations can be taken into the field.  

Selecting the Expand LatLong Box options under the Terrain 

Corrections menu opens the LLBoxExpand dialog (Figure 9-
1).  

Each Latitude and Longitude direction has a paired text box.  

 

Figure 9-1 LLBoxExpand Dialog 

 

Calculation Steps 

1. Enter the Latitude/Longitude in degrees, minutes, seconds or 
in decimal degrees for the survey area in the inner text box. 

The value is displayed with black text. Table 9-1 shows 

examples of acceptable formats. 
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Table 9-1 Example Acceptable Formats 

Use upper or lower case letter for directions indications. 

Or use symbols:  plus (+) for North or East and minus (–) for South or 

West.  

Format with or without spaces are acceptable. 

Example Decimal Format DD.D 

DD MM SS 

DD.MM.SS 

Example Degree Format  46.2N or 46.2n or 46.2 N or 46.2 n 

46.2 +  

46 2 02 N or 46 2 02n 

46.2.02 + 

 

2. Enter in the Expansion distance in kilometers and select a 

Degree format to return the expanded coordinates in the 

format most convenient for your chosen data source.  

3. Click Calculate to add the distance and return the calculated 
latitude and longitude.  

The outside Latitude and Longitude boxes show the calculated 
values in red text. The values in the calculated text boxes 

cannot be edited but can be copied. The values are not saved 
and are not written to a file. Copy the calculated value and then 

paste it into the data retrieval engine used at your site. 

From Survey  

If using this utility post-survey, use the From survey button.  

1. Click on the From survey button.  

2. Enter the Expansion distance in km. 

3. Click Calculate to add the distance and return the calculated 

latitude and longitude. 

All the processed lines from all flights in the entire survey are 
retrieved. Depending on the survey size, it may take several 

minutes before the survey Latitude/Longitude values appear in 
the inside text boxes. Once the survey values are retrieved then 
copy and paste it into the data retrieval engine used at your 

site. 
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Terrain Correction Grid 

The Terrain Correction Grid utility calculates gravity terrain 
effects using Parker's Fast Fourier Transform (FFT) based 
algorithm. It is recommended to do these calculations as soon 

as the survey area boundaries are available so the terrain 
calculations can be taken into the field.  

Select the Terrain Correction Grid option under the Terrain 

Corrections menu to launch the AbTerrGUI dialog (Figure 9-
2).  

 

Figure 9-2 AbTerrGUI Dialog 

1. Enter the Flight height in meters. 

- This is the planned flight height for the survey.  

- If the survey has already been completed then enter the 
average flight height in meters.  

2. Enter the Rock density in g/cm³  

- This value is based on the local geology of the survey or 
survey specifications.  

- Default value 2.67 g/cm³ 

3. Enter the Water density in g/cm³ 

- The default is the standard density for sea water (1.03 

g/cm³) 

- This is only used if the regional and/or local terrain grids 

extend offshore. 
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4. Enter the Extension % 

- The Extension % is added to the data to avoid FFT 

wrap-around edge effects.  

- The default is 25%  

5. Click Browse button for the Regional topo grid.  

- Navigate to the location of the regional topographic data.  

- Select the regional terrain data file. 

- Click Open. 

6. Click Browse button for the Local topo grid. 

- Navigate to the location of the local topographic data.  

- Select the local terrain data file. 

- Click Open. 

7. Click Browse button for the Output terrain effect grid. 

- Navigate to the location for the output file.  

- Click open to accept the default output file name 

(Terr.grd) or type in a new output file name. 

- Click Open.  

8. Click Calculate to begin the calculations.  

- A pop-up window displays processing messages. The 
Wait button is a reminder to wait and is not an action 
button.  

- The window closes and returns to the AGSYS main screen 
when completed. 

9. Or click Cancel to close the Output terrain effect grid 
dialog and return to the AGSYS main window. No calculations 
are completed and entered data is not saved. 

 

WARNING Be prepared to wait several minutes. Do not click anywhere in 
the AbTerrGUI dialog or the pop-up processing window, it may 
cause unpredictable behavior. Once calculations have started 

they cannot be cancelled.  

 Attempting to close any AGSYS dialog boxes via the Windows 
close button is not recommended and may result in 

unpredictable behavior.  
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When calculations are complete, enter the survey and flight data 
into AGSYS. Then select a flight by clicking Set active flight on 

the Flights menu. Then in the flights dialog, select a flight and 
click Accept.  

To apply terrain corrections to a specific line or all lines, go to 

the Line menu, select Apply terrain corrections and click on 
a specific line or click All lines. In the Terrain effect grid 
browse window, navigate to the terrain corrections data folder 

and select the terrain correction output file and click Open. The 
browse window closes when complete. The terrain effect is 
loaded into the teff channel, and the Bouguer anomaly is loaded 

into the BGA channel. 

To view the Terrain Effect or Bouguer Anomaly trace, click 
on View processed data on the Lines menu. Select one of 

more traces to display by using typical windows selection 
methods like SHIFT-click or CTRL-click to select the desired 
channels.  
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Contact 

For questions, service request or support request please contact 
Micro-g LaCoste Customer Service at Info@microglacoste.com. 

Support Request 

Providing complete detailed information helps us diagnose and 

respond with a more accurate and timely response. For large file 
uploads, contact Customer Service for ftp site instructions.  

• Instrument model and serial number 

• Scenario description 

o Setup  

o Environment 

• Complete Detailed Problem Description 

o Include step-by step instructions for reproducing the 

problem. 

• Screen Shots and/or Video as appropriate 

• Applicable Files: 

o Still reading Pre/Post screen shots 

o Data Files and appropriate local.ini file 

o Flight Logs 

o Error Logs (AGSYSErrLog.txt) 

• Text of any error message if applicable. 

• AGSYS software version (Found in the AGSYS Help menu) 

• PiperPro software version (Found in the PiperPro Help 

menu). 

mailto:Info@microglacoste.com
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Turnkey Airborne Gravity System 6 /7 (TAGS-6 /7) outputs data 
at a rate of 20Hz. The TAGS-6 /7 data packet is a serial ACSII 

string containing meter data and written to a *.txt file.  

Sample TAGS-6 Output Data File (*.txt) 

This file is quite large and the following is a short sample of the 
file. 

TAGS-6 Gravity Survey 
 

Software Version: 1.140129 
Date: 2014-02-24 
Time: 16:04:41 
Meter ID: TAGS-6 180 
Conversion Factor: 8388607.000000000000000 
Gravity Range: 500000.00000 
Gravity Calibration Factor: -418676.000000000000000 
Long Level Gain: 266.000000000000000 
Long Level Zero: 0.000000000000000 
Cross Level Gain: 266.000000000000000 
Cross Level Zero: 0.000000000000000 
Meter Temperature Gain: -0.102600000000000 
Meter Temperature Zero: 104.640000000000000 
Meter Pressure Gain: 1.095043000000000 
Meter Pressure Zero: -0.025242000000000 
Beam Gain: 10.000000000000000 
Beam Zero: 0.000000000000000 
20 Hz Data Filter: Exact Blackman 
20 Hz Levels Filter: Exact Blackman 
5 sec Levels Filter: Enabled 
GPS Time Stamp: Enabled 
 
Column Headers: 
Gravity(mGals),LongLevel(AD Units),CrossLevel(AD Units),Beam(AD 
Units),MeterTemp(°C),MeterPres(mbar),Status,Timestamp(YYMMDDHHMMSS
mm),CheckSum 
41344.208022142,1.339987438,34.865675314,-
0.664645513,60.009,958.137383000,-0.890616638,9,00010100004760,-238060 
41343.209820653,1.320200601,34.763094516,-
0.664620479,60.009,958.137383000,-0.877432355,9,00010100004765,-241873 
41343.159910579,1.397889304,34.799402094,-
0.664601405,60.009,958.137383000,-0.929039196,9,00010100004770,-238256 
41344.158112068,1.501453102,35.075910458,-
0.664655049,60.009,958.137383000,-0.997948386,9,00010100004775,-226330 
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41344.108201993,1.540360873,35.166663547,-
0.664709886,60.009,958.137383000,-1.023893100,9,00010100004780,-222281 
41343.958471770,1.557832904,34.830604414,-
0.664622863,60.009,958.137383000,-1.035371364,9,00010100004785,-232247 
41344.657212813,1.542929356,34.176719210,-
0.664450009,60.009,958.137383000,-1.025199425,9,00010100004790,-253202 
41344.956673259,1.508936585,33.486399589,-
0.664429744,60.009,958.137383000,-1.002582349,9,00010100004795,-276028 
41344.058291919,1.466350492,33.095736396,-
0.664534648,60.009,958.137383000,-0.974440708,9,00010100004800,-289756 
41343.609101249,1.506653488,32.850430352,-
0.664527495,60.009,958.137383000,-1.001212669,9,00010100004805,-296201 
41343.708921398,1.587418030,32.665055593,-
0.664410670,60.009,958.137383000,-1.054697478,9,00010100004810,-299399 
41344.307842291,1.598294449,32.575095245,-
0.664351066,60.009,958.137383000,-1.061828620,9,00010100004815,-301850 
41345.006583334,1.548732227,32.714681234,-
0.664398749,60.009,958.137383000,-1.028975755,9,00010100004820,-299060 
41344.906763185,1.538236325,33.022899273,-
0.664398749,60.009,958.137383000,-1.022002290,9,00010100004825,-289664 
41345.006583334,1.632445768,33.417145660,-
0.664333184,60.009,958.137383000,-1.084487895,9,00010100004830,-274202 
41345.505684078,1.684956990,33.626080707,-
0.664309342,60.009,958.137383000,-1.119332670,9,00010100004835,-265942 
41344.457572515,1.641926961,33.308254636,-
0.664349874,60.009,958.137383000,-1.090813969,9,00010100004840,-277330 
41343.110000504,1.571753451,32.591869663,-
0.664395173,60.009,958.137383000,-1.044265406,9,00010100004845,-302141 
41343.159910579,1.554535097,31.737674443,-
0.664402326,60.009,958.137383000,-1.032836734,9,00010100004850,-329624 

Sample TAGS-7 Output Data File (*.txt) 

This file is quite large and the following is a short sample of the 
file. 

/ PiperPro Gravity Survey 
/  
/ Software Version: 1.190708 
/ Date: 2022-11-15 
/ Time: 13:52:46 
/ Meter Type: TAGS 
/ Meter Frequency: 20 Hz 
/ Meter ID: 224 
/ Conversion Factor: 8388607.000000000000000 
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/ Gravity Reference: 0.00000 
/ Gravity Calibration Factor: -418676.000000000000000 
/ Long Level Gain: 31.279000000000000 
/ Long Level Zero: -0.269000000000000 
/ Cross Level Gain: 31.292000000000002 
/ Cross Level Zero: -0.002000000000000 
/ Z Level Gain: 1.000000000000000 
/ Z Level Zero: 0.000000000000000 
/ Long Gyro Gain: 1.000000000000000 
/ Long Gyro Zero: 2700.000000000000000 
/ Cross Gyro Gain: 1.000000000000000 
/ Cross Gyro Zero: -525.000000000000000 
/ Z Gyro Gain: 1.000000000000000 
/ Z Gyro Zero: 0.000000000000000 
/ LGC Scale: 1.550000000000000 
/ XGC Scale: 1.900000000000000 
/ Meter Temperature Gain: -0.000013845056130 
/ Meter Temperature Zero: -5.690484099000000 
/ Meter Pressure Gain: 0.000061142066000 
/ Meter Pressure Zero: 517.000000000000000 
/ Beam Gain: 10.000000000000000 
/ Beam Zero: 1.775000000000000 
/ VCC Coefficient: 0.000000000000000 
/ 20 Hz Data Filter: Exact Blackman 
/ 20 Hz Levels Filter: Exact Blackman 
/ GPS Time Stamp: Enabled 
/  
/ Column Headers: 
Gravity(mGals),LongLevel(Gals),CrossLevel(Gals),ZLevel(Gals),LongGyro(10*mDe
grees/sec),CrossGyro(10*mDegrees/sec),ZGyro(10*mDegrees/sec),LGC(mGals),
XGC(mGals),Beam(V),MeterTemp(°C),MeterPres(mbar),VCC,Status,Timer(ms),Ti
mestamp(YYMMDDHHMMSSmm),CheckSum 
-5.4402,0.89331,1.44298,31.23105,-
418.00000,459.00000,5557.00000,0.41977,0.76056,1.396036,55.702,845.275,1.
247099,129,50,22111513521935,263307663 
-1.6470,0.82089,0.42399,31.23213,-
578.00000,811.00000,5639.00000,0.80264,2.37437,1.395976,55.702,845.277,1.
145949,129,50,22111513521940,263024288 
-3.9928,-0.05679,-0.72849,31.24707,-
616.00000,647.00000,5518.00000,0.91164,1.51118,1.396036,55.701,845.277,-
0.079285,129,50,22111513521945,262605154 
-6.8377,-0.88378,-1.21296,31.25309,-
588.00000,726.00000,5547.00000,0.83065,1.90274,1.396054,55.701,845.274,-
1.233806,129,50,22111513521950,262304111 
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-3.5935,-1.36131,-1.08299,31.25219,-
492.00000,964.00000,5519.00000,0.58156,3.35476,1.396057,55.701,845.277,-
1.900473,129,50,22111513521955,262203609 
-4.6416,-1.19565,-0.36773,31.24492,-
324.00000,664.00000,5438.00000,0.25220,1.59163,1.396073,55.701,845.272,-
1.669209,129,50,22111513521960,262378581 
-6.4384,-0.28611,0.69213,31.24373,-
281.00000,691.00000,5514.00000,0.18970,1.72371,1.396041,55.702,845.272,-
0.399423,129,50,22111513521965,262896729 
-3.9928,0.60346,1.41867,31.23779,-
356.00000,776.00000,5485.00000,0.30448,2.17386,1.396034,55.701,845.274,0.
842445,129,50,22111513521970,263280319 
-6.1389,0.77053,1.30213,31.23154,-
535.00000,592.00000,5474.00000,0.68766,1.26518,1.396062,55.702,845.276,1.
075703,129,50,22111513521975,263241109 
-3.3440,0.27731,0.77759,31.23332,-
515.00000,680.00000,5498.00000,0.63720,1.66926,1.396028,55.702,845.277,0.
387132,129,50,22111513521980,262983194 
-4.2424,-0.47596,0.30539,31.23874,-
593.00000,831.00000,5555.00000,0.84484,2.49293,1.396011,55.702,845.276,-
0.664451,129,50,22111513521985,262700246 
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There are at least three ways to get your coordinates for the 
GPS base antenna:  

1. Use the average position from the GPB file,  

2. Use GrafNet and survey the location yourself,  

3. Submit your data to an online service. 

 

NOTE Changing the GPS base station antenna coordinates will change 
all the calculated gravity anomalies, so it is best to establish one 

set of coordinates before the flights begin and use that all 

through the survey. 

Average Position From GPB File 

Using the average position from the GPB file is the easiest, but 
it has several drawbacks: 

• This location is a single-receiver position, so it can be in error 

by several meters. Each meter of error in the vertical shifts 
the gravity anomalies by 0.3 milliGals. 

• The average single-receiver position changes from day-to-
day, so you can introduce shifts between each flight if you 

use the average position from that flight’s data. 

If you must use the average position, the best procedure is to 
use the position from the first set of GPS data collected at the 
base station, and store that position in the GrafNav “favorites”; 

use the position stored in the favorites for all later GPS 
processing. 

Online Services 

An excellent recent (October 7, 2013) summary of available free 

online positioning service can be found at: 

http://gpsworld.com/a-comparison-of-free-gps-online-post-
processing-services/ 

The GPS data is collected at 20 Hz, which generally produces a 
much large data file than the online service will accept. You 

should use the GrafNav File -> GPB Utilities -> Concatenate, 

http://gpsworld.com/a-comparison-of-free-gps-online-post-processing-services/
http://gpsworld.com/a-comparison-of-free-gps-online-post-processing-services/
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Slice, and Resample utility to resample the data to 10 second 

sampling. 

For all of these services, you need to convert the .gpb files to 
RINEX (Receiver Independent Neutral Exchange) format using 
GrafNav or GrafNet:  

File -> Convert -> GPB to Rinex (the default options seem to 
work fine). 

Online Services Advantages 

The advantages of using the online services are:  

• Autoselecting of the reference stations to use. GrafNet can 
present you with a list of available stations within a specified 
distance, but it's up to you to select the stations and the 

time intervals to download. 

• Automatic handling of reference station antenna models. If 
you use GrafNet, you need to find out the antenna models 

for each reference station and apply it yourself. 

Online Services Disadvantages 

The disadvantages of the online services:  

• You need to manually cut-and-paste coordinates from the 

returned solution files into the GrafNav Favorites manager, 

INCLUDING the reference frame for the solution.  

• The reference station data availability may not be as prompt 

as downloading service data from inside GrafNet.  

• The auto-selected reference stations may not include 
stations which are relatively close: OPUS only uses CORS 

stations, not IGS stations, and AUSPOS only uses IGS 
permanent stations.  GrafNet allows you to mix stations 

reporting in different networks. 

Please consult the Waypoint manual for instructions on using 
GrafNet. 

NOTE Using online services or GrafNet requires Internet access. 
Reference station data availability has delays ranging between 

hours to a few days, so you must plan accordingly. 
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Table C1 Raw Gravity (in UTC time, 20 Hz sampling) 

Channel Units Description 

grav mGals Raw meter gravity (unscaled) 

lacc Gals Long accelerometer 

xacc Gals Cross accelerometer 

beam A/D units Beam position 

temp degrees C Meter temperature,  

mpress mbar Meter pressure 

vcc arb1 VCC cross-coupling channels 

status Flag bits Meter status flags 

checksum  Data checksum (internal MGL diagnostic use only) 

timer  Timer (internal MGL diagnostic use only) 

clamped Boolean Meter is clamped. 

unclamped Boolean Meter is unclamped. 

sync Boolean GPS Sync 

online Boolean Meter in online mode? 

MissGrav Boolean Gravity data is missing? 

VEcc arb1 VE cross-coupling channel 

Note: 
1: arb is arbitrary units: scaling to mGals is done using the cross-coupling coefficients. 

Table C2 Raw GPS (in GPS time, 20 Hz sampling) 

Channel Units Description 

lat  Signed decimal degrees, + N Latitude in WGS84 datum 

lng Signed decimal degrees, + E Longitude in WGS84 datum 

ell_ht Meters WGS84 ellipsoidal height 

orth_ht Meters Orthometric height using selected 

Waypoint geoid (default is EGM96) 

nsats Count Number of GPS satellites in solution 

pdop Scale factor Position dilution of precision 

MissGPS Boolean GPS data is missing? 
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Table C3 Merged Grav/GPS (in GPS time, 20 Hz sampling) 

Raw gravity channels shifted to GPS time 

Raw GPS channels 

Channel Units Description 

ve Meters/sec GPS east velocity 

vn Meters/sec GPS north velocity 

vz Meters/sec GPS true vertical velocity 

crse degrees Aircraft course, clockwise from 0 at due 

north 

vel Meters/sec Aircraft speed 

eacc mGals GPS east acceleration 

nacc mGals GPS north acceleration 

zacc mGals GPS vertical acceleration 

gcacc mGals GPS acceleration in cross aircraft direction 

(+ towards right wing) 

glacc mGals GPS acceleration in long aircraft direction 

(+ towards nose) 

ctilt degrees Platform tilt from vertical in the cross 

direction 

ltilt degrees Platform tilt from vertical in the long 

direction 

vtilt degrees Platform tilt from vertical  

Eotvos mGals Eotvos effect 

fa mGals Second-order free-air correction 

IGF mGals International gravity formula value 

IGFinPlat mGals Component of IGF in the platform vertical 

direction 

Platup_1 Unit vector component Component of platform vertical in the cross 

aircraft direction 

Platup_2 Unit vector component Component of platform vertical in the long 

aircraft direction 

Platup_3 Unit vector component Component of platform vertical in the 

vertical 
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Table C4 Processed (in GPS time, 1 Hz sampling) 

Channels as in Merged Grav/GPs 

GPSterms mGals All GPS-related gravity correction terms 

VCC arb VCC cross-coupling 

mGalVCC mGals VCC cross-coupling, scaled to mGals 

mGalVE mGals VE cross-coupling, scaled to mGals 

metgrav mGals Gravity measurement of meter (includes offset to absolute 

gravity using still readings) 

FAA mGals Free-air anomaly (Recomputed meter gravity – GPS 

corrections) 

xcoord meters UTM easting, WGS84 datum 

ycoord Meters UTM northing, WGS84 datum 

origFAA mGals If line has been spike edited, contains original unedited FAA 

channel 

EditMask Boolean Flags for data removed and interpolated in spike editing 

Note: 
All gravity channels have sub-second phase shift applied 
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Tip 

Num 

Problem/Error 

Message 

Solution 

1 Click Open Survey on 

Survey menu and 

survey not listed. 

 

The survey folder name was deleted, renamed or 

moved outside of AGSYS using Windows explorer 

commands. To access the moved or renamed survey, 

click Open Survey on the Survey menu and select the 

survey folder.  For instructions on deleting, renaming 

or moving a survey refer to Section 04.  

2 Made changes to 

survey, basetie or 

meter information and 

line data needs 

recomputing. 

When survey, basetie or meter information has 

changed the line data which references that 

information is not automatically recomputed. Select 

Process on the Lines menu and click All lines to 

reprocess all of the line data. See Section 4 for Survey, 

Basetie and Meter configuration.  

3 Unsure whether base 

station Master GPS data 

and aircraft Remote 

GPS data files were 

correctly copied into 

AGSYS i.e. they might 

be switched.  

Before processing the Master and Remote raw GPS 

data through GrafNav, check that the Master/Remote 

GPS data were correctly downloaded to AGSYS. Refer 

to Section 06 Raw Gravity And GPS Data Files for 

downloading instructions. Once processed through 

GrafNav it becomes a difficult manual process to fix. To 

check the downloaded GPS data in AGSYS, execute 

following steps: 

Open the Survey and set the Active Flight 

On Flights menu point to Flight Data Utilities then 

click View Raw GPS and select Master or select 

Remote 

In the GPBView window, watch the “Height” variable as 

you scroll through the data. If it is the Remote GPS 

data the height values will vary dramatically. If it is the 

Master GPS data the height values are all within a few 

meters of a constant value.  

If needed re-copy in the data  

4 Master/Remote data 

swapped and already 

processed through 

GravNav 

There is no easy way to swap the data once it has been 

processed through GrafNav. Contact Micro-g LaCoste 

for assistance.  

5 The Channel Display 

window does not 

initially display the 

default selected trace.  

From the Flight menu, Set active flight, then Click 

Flight data utilities and select either View 

processed GPS or View Raw Gravity. The selected 

default trace does not automatically display. If you 

would like to display the default trace, simply click on 

highlighted trace. You may also view one or more 

traces by using typical windows selections methods like 

CTRL-click and SHIFT-click to select multiple traces.  

http://section04.doc/
http://section04_070609.doc/#AerogravMenus
http://section04_070609.doc/#AerogravMenus
http://section06.doc/#Section6RawGravityGPSDataFiles
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Tip 

Num 

Problem/Error 

Message 

Solution 

6 Need to reprocess flight 

using a different master 

GPS antenna 

coordinates.  

To reprocess a flight execute the following steps: 

Set the active flight (Select Set Active Flight on the 

Flight menu) 

Run GrafNav (On the Flight menu point to Flight Data 

Utilities and select Run GrafNav) 

Edit the Master (On the View menu in the GrafNav 

dialog window, point to GNSS Observations select 

Master ‘Name’ and then click Edit.) 

Check the Name field in the Edit Station Info dialog 

for the Station ID name used. If you need to change 

either click on Select From Favorites or Add to 

Favorites.  

Edit the Remote (On the View menu in the GrafNav 

dialog window, point to GNSS Observations select 

Remote and then click Edit.) Then click OK.  

Process GNSS differential by: 

− Clicking on the airplane icon, or 

− Click F5 key or 

− On the Process menu click Process GNSS 

(differential) 

● Export to file (On the Output menu click on Export 

Wizard) 

● Click Yes to overwrite the TAGS-6.txt file and close 

the GrafNav dialog window. Then wait until the Load 

GPS is Done.  

● Reprocess the Lines (on the Lines menu select 

Process and click on All lines) 

7 Cannot start AGSYS 

using the shortcut 

Right click on the desktop icon or the Windows Start 

menu entry and select Properties.  

Edit the Target location. 

Delete the extra .exe extension from the Target 

location. 

8 Where to find the 

AGSys6ErrLog.txt file 

The Error log location is the dependent upon where 

AGSYS was launched. If launched from the desktop 

icon, the log file is also located on the desktop. If 

launched from the installation folder, the file is located 

in the installation folder. 

9 Print issues: Printed 

plot does not match 

displayed plot. 

There are known problems using MATLAB pdf. 

Recommend downloading (Refer to Section 02) and 

installing ghostcript (Refer to Section 06). 

 


